Oral history is the recorded recollections of participants in and/or eyewitnesses to historical events. The purpose of the Abraham Lincoln Presidential Library oral history program is scholarly research. The audio or video file(s) of an oral history interview is considered the oral history document of record at ALPL. As much as possible, however, it is the goal of this program to complete transcriptions of the interviews as well. It is well documented that researchers prefer to use transcripts of interviews over the actual recording by a very wide margin. The audio or video file and its transcript—which is then edited—are primary historical sources. Primary historical documents are useful to scholars in many fields.

A transcript is, at best, an imperfect representation of an oral interview. Our goal at ALPL is to create a final transcript that clearly captures our interviewees’ unique personality while also presenting their substantive comments in ways that are clearly understood and accessible to researchers and the general public alike. That requires some judicious editing to achieve that goal. While transcription is more a science than an art, editing is very much an art, requiring many substantive decisions by the editor. This document, the ALPL Oral History Transcribing & Editing Style Guide, will provide general guidelines to those who transcribe, audit and edit interviews on behalf of the Abraham Lincoln Presidential Library.

Processing an interview: Processing an interview at ALPL is a multi-stepped process:

1. **Creating the Transcript:** The transcriber creates a near-verbatim document of the interview.

2. **Auditing of the transcript:** The auditor, preferably the same person who serves as interviewer, listens to the original interview and compares that to the transcript.

3. **Editing:** An editor, often the document’s transcriber, carefully reads the original transcript and revises the interview to enhance clarity and readability while retaining the interviewee’s personality and original intent.

4. **Interviewee’s Review:** The interviewee will be given the opportunity to review the edited transcript to correct factual errors, correct spelling, and on occasion clarify statements made during the interview. They are cautioned to resist the temptation to rewrite their statements, and are reminded that the audio or video file remains the interview of record.

5. **Final Edit:** The Director of Oral History or a designated representative will conduct a final edit of the interview, using the standards delineated in this document, prior to the interview being archived.
Transcribing

An oral history transcript should reflect as closely as possible the actual words, speech patterns, and thought patterns of the interviewee. The narrator's word choice, including his/her grammar, and speech patterns should be accurately represented. Oral history is not an exercise in literary composition; the transcriber should avoid value judgments about the grammar or vocabulary of an interviewee. To retain validity in transcripts, much of the editing should be done by the interviewee.

A transcript is at best an imperfect representation of an oral interview. The transcriber's most important task is to render as close a replica to the actual conversation as possible. Accuracy, not speed, is the transcriber's goal.

Although the resulting transcript may not exactly resemble the audio file, the transcriber serves as first editor by putting words on paper. Therefore, producing the transcript is a crucial step in creating a document worthy of the narrators’ and researchers’ time.

Editing the Transcript

Once an interview transcript has been completed and the auditor has verified that the transcript is an accurate reflection of the interview itself, it is now time to edit the interview transcript. The editor will carefully read the transcript and revise the interview to enhance its clarity and comprehensibility while still retaining the interviewee’s (also referred to as the narrator) personality and original intent.

The Style Guide

The Abraham Lincoln Presidential Library Oral History Program has developed its transcribing and editing guidelines plus a more detailed style guide to assist in transposing the spoken word into written language. These guides are adapted from the Baylor University Institute for Oral History Transcribing Style Guide and Transcribing Guidelines. Transcribers and editors needing information on matters pertaining to spelling, punctuation, and usage not covered in this style guide should refer to the Merriam-Webster Dictionary and the Chicago Manual of Style, 15th edition.

Processing an Interview

Assignment of an Interview to transcribe: The Director of Oral History (Mark DePue) will assign you a specific interview recording to transcribe, plus an abstract, word list and other associated documents. He will also give you the ALPL Interview number for that document. (See Appendix 1.) Please note that the interview might consist of several sessions with the same individual. As a matter of policy, you will be expected to transcribe an entire interview

1 http://www.baylor.edu/Oral_History/Styleguiderev.htm
series in order to retain continuity throughout. In most cases, it will take you multiple
transcribing sessions before you have completed the interview series. Before starting, review
the word list to anticipate the kinds of unique words you will encounter, consult it as you
transcribe, and check it again when you complete the transcript to make sure you caught every
word listed.

**Oral History folder on the ALPL ‘M’ Drive:** Upon completing your initial training and in-
briefing as a transcriber or editor, our IT (information technology) staff will assign you an
‘M’ drive on the ALPLM computer server. After meeting with the Director of Oral History to
receive a specific assignment, all necessary files, both text and audio files, will be moved to
your ‘M’ drive, where you will do your work. Upon receiving your interview assignment, you
will find the audio file of the interview on the ‘M’ drive along with the abstract in the folder
with your interviewee’s name. (In the ‘M’ drive, you should find a folder with your
interviewee’s name which contains the files you will need.) You will also receive an
Interview Folder (manila folder) of materials on your subject, which you will also be expected
to maintain throughout the time you work on the interview. **Do not remove this folder from
the library premises.** Please keep this in the box provided for you at the transcription station.
Save your transcript to the appropriate oral history project folder on the ‘M’ drive. Consult the
ALPL File Naming Protocol document (Appendix 2) for guidance in naming and saving files.

- **Transcript Shell:** To start a new transcript, create a new MS Word document using
  the Blank Transcript Template document template (see the ‘Templates’ folder in your
  ‘M’ drive).

**Registering your progress on the transcript:** When the transcript for an interview is
complete and the document has been saved, inform the Director of Oral History (Mark
DePue) of the same. If he is not available, email him, indicating your progress.

*You are a significant part of the process of creating a new historical document. Your
careful attention to detail, your patience in working out solutions to problems, and your
persistance in tackling each unique interview will be rewarded by the knowledge that you
have helped preserve some fascinating chapters of twentieth and twenty-first century
history. If you have any questions, ask! Remember, you are working with people who
make their living asking questions.*

**Transcribing**

The following guidelines are designed to acquaint volunteers with the process of transcribing
oral history interview recordings.

**General:** The goal of the Abraham Lincoln Presidential Library (ALPL) Oral History
Program is to transcribe all newly created oral histories in an accurate and timely manner.
Specifically, we seek to create ‘near verbatim’ transcripts, in other words, transcripts that are
nearly identical to the spoken word, with the following specific guidance provided:

1. Type the words you hear, in the order you hear them.

2. Punctuate according to the sense of the words as spoken.
3. Unusual pronunciations or colloquialisms should not be spelled phonetically. (e.g. type ‘going to,’ not ‘gonna’)

4. Retain all contractions.

5. Retain only enough of the narrator’s crutch words (you know, like, okay, etc.) to retain the style of speech, but otherwise skip subsequent crutch words that distract from the narrative flow.

6. Delete most of the interviewer’s feedback words, such as okay, right, uh-huh, etc.

7. **Do not** include false starts or fumbles by either the narrator or the interviewer.

8. **Do** include ‘stage directions’, such as (telephone rings), (laughs), etc.

Further Guidance:

1. Become familiar with this document, the *ALPL Oral History Transcribing & Editing Style Guide* and keep it handy to use for reference. It covers many situations you will encounter in transcribing the spoken word. Consult it first; for cases it does not address, refer to the *Chicago Manual of Style, 15th edition*.

2. When a situation arises that is not covered in either the *Style Guide* or the *Chicago Manual*, ask for help.

3. Use the *Merriam-Webster Dictionary* for spelling help. For special terminology, consult the word list you received from the interviewer, a reference book in the office or an authoritative Internet site. If you cannot locate a correct spelling, ask for help.

4. Practice using the Start-Stop transcribing machine. The Oral History program has versions for both digital audio recordings and cassette tapes.

5. You will need to be proficient in the use of Microsoft Windows and Microsoft Word software programs and also be experienced in using both print and online reference sources.

**What to do with names and words you do not know:**

1. Use Microsoft Word’s spell checker. It is a necessary first step; do not neglect it. There are many errors it will not catch, and it is no help for names and jargon you might encounter, but it will help start the correction process.

2. If you do not know and cannot precisely determine the spelling of a name, place, or other word, you must underline it and follow it with two question marks in parentheses.

   Example: We used to use a squirgbaggle(??), but you can’t find those anymore.
This will let the auditor, initial editor, the interviewee, and the final editor know that the spelling has not been confirmed. Otherwise, all spellings will be assumed to be correct. The underlining will draw the attention of the editor and the interviewee when they review it. You may even want to look it up later and this step will help you locate it for correction.

If the word is repeated, type it exactly the same each time, including the underlining and question marks. This will shorten the process of correcting it with Microsoft Word’s find-and-replace function if the correct spelling is found and verified.

3. Do not assume you know how to spell words in the interview. Names, especially, have varied and unfamiliar spellings a lot of the time. There are authoritative reference sources in the office as well as online for checking spellings. If you cannot determine a correct spelling with reasonable effort and certainty, however, it is better to leave it underlined.

**Special formatting and characters:**

1. Diacritical Marks In Foreign Words:
   
   Click to place the cursor in the transcript place where the letter and accent should appear. On the menu bar at the top of the window, choose “Insert ➔ Symbol,” then scroll down to find the specific diacritic you need. In the character selection window, double-click on the symbol or accented character you need. You may also find information on diacritical marks by going to “Help”, then typing in “diacritical marks” in “search for”. See the question “Keyboard shortcuts for diacritical characters” for a listing of marks and keys for typing them.

   Examples: Cortés, São Paulo, résumé, Zweibrücken

2. Em-Dashes:
   
   If you type two hyphens and do not include a space before the hyphens, Microsoft Word normally transforms it into an em-dash (—). To create an em-dash manually, type Alt + 0151— that is, hold down the "alternate" key and type, using the numerical pad on the right side of the keyboard, the numbers 0151. The en dash can be typed as Alt + 0150.

3. Italics Rather Than Underlining:

4. For titles of books or for foreign phrases, highlight the words and click on ‘I’ on the toolbar at the top of the window. Underlining is reserved for proper names or expressions that are not verified by a word list or for unintelligible portions of the interview.

**What to do when you cannot understand what is said:**

- Case 1: When you are unsure of what is said but can make an educated guess, underline the questionable portion and add two question marks in parentheses.

  Example: My first grade teacher was Mrs. Evans(??)
• Case 2: If you and those you consult cannot understand at all what is said, leave a blank line and two question marks in parentheses. Length of line indicates approximate length of missing words.

Example: My _________(??) was Mrs. Evans.

• Case 3: If a speaker lowers his/her voice, turns away from the microphone, or speaks over another person, it may be necessary to declare that portion of tape to be unintelligible.

Examples: My first—(unintelligible)

or

My first—(both speaking; unintelligible)

Choosing what to transcribe:

• While there is some merit in having an absolutely verbatim tape which includes all the feedback words (such as “um-hm” and “yeah”), too many interruptions in the flow of the interview make for tedious transcribing and exhausting reading. Knowing when to include feedback and when to omit it calls for very careful judgment. Usually the interviewer’s feedback words and sounds are intended to encourage the interviewee to keep talking. If every other line or so of the transcript is the interviewer’s feedback, go back and carefully evaluate the merit of each instance. Don’t include them all, especially if they interrupt the interviewee’s comments in midstream. Only if the feedback is a definite response to a point being made by the interviewee should you include it. When in doubt, ask.

• Indicate a pause in recording when the recording is stopped and then started again, when sound fades out, et cetera:

Example: (pause in recording)

Important things to remember:

• Remember as you work that accuracy is your goal, not speed.

• Save your transcript document at least every fifteen minutes to insure that your work will not be lost.

Care for your body. If your chair is uncomfortable, take time to adjust the back rest and seat height to fit your needs. After every forty-five minutes at the computer, get up and stretch, walk down the hall, rest your eyes, your back, your arms, your mind. Take the time to refresh your body and take a break from the computer.

Auditing the Interview

Auditing compares the actual interview to the written transcript. Auditing is not editing. You are merely insuring the accuracy of the transcript, while also checking for spelling, grammar, etc. Ideally, auditing should be done by the interviewer, but this is often not possible. If you are assigned to do an audit of an interview, beware working too long on the project. Auditing
can be a bit hypnotic, so take frequent breaks, and return to the project when you’re refreshed. Audit no more than a couple hours at a time. What should you look for?

- Watch carefully for spelling and punctuation that accurately reflects the narrator’s intent.

- Keep the Word List close at hand, and refer to it often.

- Be listening for words that were misunderstood, inadvertently added or omitted.

- Try to fill in those spots where the transcriber could not make out what was said.

**Editing the Transcript**

**Editing Guidelines:** As with the transcribing step, become familiar with the ALPL Oral History *Transcribing & Editing Style Guide* and keep it handy to use for reference.

1. The purpose of the Abraham Lincoln Presidential Library oral history program is to create oral histories for scholarly research. Therefore, accurately conveying the interviewee’s intent is more important than precisely capturing the narrator’s speech patterns, dialect or mannerisms. That is not to suggest that these things are not important, but that they are less important than creating a clear and comprehensible final transcript. As Cullom Davis explained in his book *From Tape to Type*, “The edited transcript must clearly convey the speakers’ meanings and read smoothly enough that the reader can understand it without having to stop and reread.”

2. Produce an accurate portrait of the narrator. Avoid personal or social embarrassment to the narrator.

3. Be a tolerant critic. Your job is to capture the essence of the original interview while also making it comprehensible to patrons. Consider changing only what you cannot understand at first reading.

4. Retain improper grammar, poor sentence structure, unusual word forms and other elements that might be contrary to normal syntax. Your goal is achieving clarity while retaining the essential character of the spoken word.

5. Punctuate according to the sense of the words as spoken.

6. Unusual pronunciations should not be spelled phonetically. (e.g. type ‘going to,’ not ‘gonna’)

7. Retain all contractions.
8. Retain only enough of the narrator’s crutch words (you know, like, okay, etc.) to retain the style of speech, but otherwise delete subsequent crutch words that distract from the narrative flow.

9. Remove most of the interviewer’s feedback words, such as okay, right, uh-huh, etc.

10. Do not include false starts or fumbles by either the narrator or the interviewer unless they reveal something essential to the reader’s understanding of the interview.

11. If a narrator’s statement is vague or difficult to follow due to haphazard organization, reorganizing is appropriate, but only if the editor is certain of the narrator’s original intent.

12. Editors may add material to the transcript for clarification, but will place the material in brackets. I was assigned the BAR [Browning Automatic Rifle] when I got to Korea.

13. Do include ‘stage directions’, such as (telephone rings), (laughs), etc.
ABBREVIATIONS:

In general, avoid abbreviation in oral history transcripts. One general rule requires that a civil or military title appearing before a surname only should be spelled out, but it should be abbreviated before a given name and/or initial(s) plus surname.

Governor Ogilvie, but Gov. Richard Ogilvie

Do not abbreviate:

• okay
• *et cetera*
• names of countries, territories, provinces, states, or counties
• *doctor* when used without an accompanying name
• *Senator, Judge, Bishop, General, Professor, Brother,* or any other political, academic, civic, judicial, religious, or military title when it is used alone or when it precedes a surname alone, i.e., *Judge McCall*
• *the Reverend or the Honorable,* when *the* is part of the title preceding the name
• books of the Bible
• names of the months and days
• terms of dimension, measurement, weight, degree, depth, *et cetera:*
  - inch, foot, mile
• part of a book:
  - Chapter 3
  - Section A
  - Table 7
• word elements of addresses used in text:
  - *Avenue, Building, North, South*
  - except *NW, NE, SE, and SW*
• portions of company names, unless the actual company name uses an abbreviation:
  - *Brother, Brothers, Company, Corporation, Incorporated, Limited, Railroad*
• *Senior* or *Junior* when following partial names:
  - Mr. Miller, Junior
  - Mr. Toland, Senior

Do abbreviate
• the following when they precede a given name and/or initial(s) plus surname:
  - *Bro.*
  - *M.*
  - *Mme* 
  - *Ms.
  - *Sr.*
  - *Dr.*
  - *Messrs.*
  - *Mmes* 
  - *Rev.
  - *Sra.*
  - *Fr.*
  - *Mlle*
  - *Mr.
  - *Rt. Rev.*
  - *Srta.*
  - *Hon.*
  - *MM*
  - *Mrs.
  - *Very Rev.*

  *Note the presence or absence of the period. For further guidance on French social titles, see *Chicago Manual of Style,* 15th edition, section 15.17, p. 562.

• Jr. or Sr. after given name and/or initial(s) plus surname:
  - John H. Smith Jr. (note that the comma is no longer required around Jr. and Sr.)
• NE, NW, SE, SW in addresses given in text
• points of the compass:
  - *N, E, S, W, NE, SE, NNW, WSW, et cetera*
• era designations:
  - *AD 70, 753 BC*
• Time designations (see also “Small Caps” under “Capitalization” below):
  - *AM, PM* (note that when small caps are used, periods are omitted; if lowercase letters are used, the correct form is *a.m., p.m. Whichever form is used, it must be used consistently throughout.)*
• Initials only, initialisms, acronyms, reverse acronyms
Celebrated persons are often referred to by a full set of initials, often without periods, that represent the full name.

JFK, LBJ

Agencies and various types of organizations in government, the military, industry, and education often are referred to by acronyms or initialisms:

AMA, IOOF, NATO, UN, USMC, USAF, USN, FDIC, SEC, AFL-CIO, or AF of L-CIO, SMU, Texas A&M

ACTIVITY AUDIBLE ON TAPE—PARENTHESES: Nonverbal sounds which occur on tape are noted and enclosed in parentheses. For such notations use no capital letters, unless for proper nouns or proper adjectives, the present tense form of verbs, and no ending punctuation. Reserve the use of parentheses for such activity notes. Descriptive terms: (laughs) when speaker laughs, or (Jeffrey laughs) when person other than speaker laughs, or (both laugh or all laugh) when more than one laughs. Use (both talking at once) or (speaking at same time)--NOT (interrupts). Other examples: (unintelligible); (telephone rings); (truck passing by); (snaps her fingers). Such parenthetical inclusions are also known as stage directions. When these occur at the end of a sentence or a clause, position them after the punctuation. Avoid editorializing; just put (laughs), not (laughs rudely)!

ADDED MATERIAL—BRACKETS: Brackets [   ] are reserved for the use of editors for notes and words not present on the tape and added to the transcript. The interviewee is provided the opportunity to add or delete material at his/her discretion on the first transcript. Such material is incorporated into the final text as indicated by the interviewee and does not appear in the first draft transcript unless indicated on a word list provided by the interviewer/first editor.

- When editors add explanatory comments, they may also need to properly cite the source of the information using standard footnoting procedures as prescribed by the Chicago Manual of Style.

BRACKETS. See ADDED MATERIAL

CAPITALIZATION. See also NAMES: A rule of thumb: When in doubt, don't capitalize. Proper names of institutions, organizations, persons, places, and things follow the forms of standard English practices. When in doubt, consult the dictionary. If still in doubt, don't capitalize. Partial names of institutions, organizations, or places are usually treated in lower case.

Do capitalize:
- names of particular persons, places, organizations, historical time periods, historical events, biblical events and concepts, movements, calendar terms referring to specific days, months, and oriental years
• titles of creative works
• references to athletic, national, political, regional, religious, and social groups: Illinois State Redbirds, Congress, Democrats, Daughters of the American Revolution, the Masons
• Capitalize Internet and Web always:
  She suggested that he search the Internet for more information. He found a Web site that answered many of his questions.
  Note that website is not a word; use Web site.

Don’t capitalize:
• oh except at the beginning of a sentence or response
• incomplete titles of persons
• names of dances, but do capitalize names of dancing events:
  They danced the jitterbug all night long. He invited her to the Society Ball.
• pronouns referring to deities:
  God in his mercy kept my child safe.

Examples: Capitalize
Board of Trustees of Mythical University
The University of Illinois
Department of History
"History of Illinois" or History 1301
study French and Spanish
McLean County
City of Bloomington (if government)
the State (if government) rests its case
New York Times, Times
the West, in the Southwest
an Easterner, Western American history
West Coast, Gulf Coast
Interstate 55, I.H. 55 or I-55
Eighth Street
Bible
Scripture(s)
Veterans Administration
Veterans Administration Hospital
the Word of God
the Fall (of Man)
the Gospel of Luke
the Book of Daniel
Madison County Court
Washington Street Bridge
American Revolution
World War I, First World War
General of the Army Douglas MacArthur
President Harry Truman

Lower case
board of trustees, the board, the trustees
the university
history department
a course in Illinois history
study history, economics, philosophy
Bloomington was in this county
I live in the city of Bloomington
the state's wild flower
the newspaper
to go west, to face southwest
a western university
the coast
the interstate, the highway
the street
biblical work
scriptural passage
the university administration
oral history office
the words of the song
the fall of 1992
the gospel
a book of poetry
county court
the bridge
the revolution of the colonies
the war
MacArthur, a general, U.S. Army
the president of the USA, presidency
the Bronze Age
the Democratic party
the Democrats (party members)
Great Depression (referring to 1930s)
Sherman Antitrust Act
Brother Smith, Aunt Kathryn
Grandmother, Grandpa Smith, Dad
U.S. Senate
Capitol (referring to building)

CHAPTER HEADINGS and SUBHEADINGS: The Abraham Lincoln Presidential Library Oral History program does not encourage the incorporation of chapter headings or subheadings into the text of a transcript as these suggest a level of structure and order not intended by the interviewee. Readers should refer to the Table of Contents for assistance in navigating the transcript.

COINED WORDS. See SPELLING PROBLEMS

COLLOQUIALISMS. See SPELLING PROBLEMS

COMMAS

No, sir.
Yes, sir.
Oh, yes.
Oh, no.
Thanks, Mrs. Pool.
Yeah, that’s right. (Note correct spelling of yeah.)
Well, I’m from California originally.
I was born in Macomb, Illinois, in 1904.
I mean, what are you going to do about it?
So we, you know, went back home.
And, of course, we were pretty angry.
She was, like, my best friend.

COMPOUND WORDS. See HYPHENS

CRUTCH WORDS. See also FALSE STARTS; FEEDBACK WORDS AND SOUNDS

Spell common crutch words as follows:

uh
uh-huh
um-hm
unh-uh

CHINESE & other ORIENTAL PLACE NAMES: Transcribers and editors may be asked to work on interviews where Chinese or Korean place names are included. The Library of
Congress is beginning the process of revising the Chinese place names currently established in a conventional English-language form (Wade-Giles system of Romanization) to newer conventions on spelling. For example, in the new pinyin Romanization system, Peking becomes Beijing, and Pusan becomes Busan. Since this program will generally be interviewing individuals whose memories and experiences are tied to the old pronunciation and spelling, ALPL will generally also use the older (Wade-Giles) spellings and accenting.

DASHES. See also ELLIPSES:
The em dash (—) is used without preceding or following blank spaces or punctuation to indicate:
1. an interruption by another speaker
2. resumption of a statement after an interruption
3. a brief pause on the part of the speaker (ellipses are used to indicate a longer pause or trailing off)

DATES. See also NUMBERS: Typing dates conforms to the rules for typing numbers:
1. Use numerals for years (1962) except when a sentence begins with a year:
   Nineteen sixty-two was an important year for me.
2. Use numerals for days when they follow the name of the month and precede the year; follow this form even when the speaker says, “August the fifth, nineteen eighty-seven.”
   Today is August 5, 1987.
3. Spell out the words for the day when the year is not expressed and the speaker uses the ordinal number:
   My birthday is August fifth.
   My birthday is August the fifth.
4. Spell out the word for the day when the day precedes the month:
   the fifth of August
5. Other examples:
   1930s; the thirties; 1989 or ’90; mid-sixties; mid-1960s.
6. When spelling out 1906, use Nineteen 0-six or Nineteen aught-six, using the same expression as used by the interviewee.

DIALECT. See SPELLING PROBLEMS

DIRECT ADDRESS:
Set off by commas:
   Pam, I know you will enjoy this.

DIVISION OF WORDS AND NUMBERS. See also HYPHENS:
- Do not hyphenate at the ends of lines in transcripts. If the automatic hyphenation function has been enabled in the word processing software, disable it. This eliminates
most issues concerning the correct hyphenation of words for the institute’s transcripts. If questions do arise, consult the Chicago Manual of Style.

- Do take care that automatic wrapping of text lines does not separate initials from a surname, parts of an acronym or abbreviation, or divisional marks such as a), (1), (i), from material to which they pertain. If necessary to keep these elements together, replace a normal space with a non-breaking space (Insert ➔ Symbol ➔ Special character in the Microsoft Word menu).

ELLIPSES. See also DASHES: Ellipses (…) should be used to indicate:
1. a hanging phrase or trailing off resulting in an incomplete sentence
2. a long meaningful pause on the part of the speaker [an em dash (—) is used to indicate shorter pauses or interruptions]

FALSE STARTS: A false start may be anything from a syllable to a sentence. Repeated words, phrases, or syllables are at times indicative of a person's thought patterns, overall speech patterns, personality patterns, or of a speaker's effort to emphasize an element of communication. Sometimes an interviewee may be deliberately ambiguous or even turgid in meaning for reasons of his own. Where to draw the line in deleting false-start material from the transcript is a difficult decision. We strive to follow a middle course leaving in enough to indicate individual speech patterns. If repetition is for emphasis as reflected in the voice of the interviewee, the repetition is always retained. Do not try to indicate stuttering unless it is intentional.

FEEDBACK WORDS AND SOUNDS: (crutch words, encouraging words, and guggles)
While there is some merit in having an absolutely verbatim tape, which includes all the feedbacks (such as Um-hm and Yeah), too many interruptions in the flow of the interviewer's remarks make for tedious transcribing now and exhaustive reading later. Knowing when to include feedback sounds and when to omit them calls for very careful judgment. Usually the interviewer's noises are intended to encourage the interviewee to keep talking. Look at your transcript. If every other line or so is an interviewer's feedback, go back and carefully evaluate the merit of each feedback. Don't include every feedback, especially if it interrupts the interviewee's comments in midstream. Only if the feedback is a definite response to a point being made by the interviewee should you include it. When in doubt, ask.

Type no more than two crutch words per occurrence. Crutch words are words, syllables, or phrases of interjection designating hesitation and characteristically used instead of pauses to allow thinking time from the speaker. They also may be used to elicit supportive feedback or simple response from the listener, such as: you know, see?, or understand?

Use of Uh:
- The most common word used as a crutch word is uh.
• When *uh* is used by the narrator as a stalling device or a significant pause, then type *uh*. But sometimes a person will repeatedly enunciate words ending with a hard consonant with an added “uh,” as in *and-uh, at-uh, did-uh, that-uh, in-uh.* Other examples are *to-uh, of-uh, they-uh.* In these instances, do not type *uh.*

Guggles are words or syllables used to interrupt, foreshorten, or end responses, and also as sounds of encouragement. Guggles are short sounds, often staccato, uttered by the interviewer to signal his desire to communicate. They may be initial syllables of words or merely *oh, uh, ah, or er.* Spelling of specific guggles:

- Agreement or affirmation: *uh-huh, um-hm*
- Disagreement: *uhn-uh*

**FRACTIONS. See NUMBERS**

**GRADES, ACADEMIC:**

Indicate a letter grade with a capital letter, no period following, no italics, no quotation marks. Show number grade in Arabic numerals with no quotation marks and no following period. Plural should have an apostrophe.

I made all A's by earning 100's on all my exams.

**HYPHENS. See also DIVISION OF WORDS AND NUMBERS:** For guidance on use of hyphens to form compound words and phrases, please refer first to section 7.90 in *The Chicago Manual of Style*, 15th edition, and then to the unabridged dictionary. Many words that were once hyphenated are no longer, so *The Chicago Manual of Style* should be relied upon as the most up-to-date authority.

- *vice-president is now vice president*
- *post-doctoral is now postdoctoral*

But when the second element is capitalized, retain the hyphen:

- *post-World War II*
- *post-Civil War*

*Hyphenate*

1. to indicate division or separation in the following:
   a) division of words into syllables, as in *syl-la-ble*
   b) spelling out a name or words, as in *H-o-r-a-c-e.* Capitalize only where appropriate.
   c) separation of numerator from denominator in a fraction expressed in words unless the numerator or the denominator is hyphenated. In that case, use / to separate numerator from denominator. Examples: *one-fifth; three/thirty-seconds*

2. to indicate unification or combination as follows:
   a) nouns made up of two or more nouns which imply the combination or unification of two or more linked things, functions, or characteristics, as in *AFL-CIO, astronaut-scientist*
b) modifiers and adjectival compounds when used before the noun being modified, not after, including those formed with numbers: a one-of-a-kind student

3. to indicate an infrequent pronunciation or meaning of a word: re-creation, recreation; re-cover, recover; re-form, reform

4. to indicate clear meaning when possible confusion could result from adding a prefix to a word starting with a vowel, as in co-op--usually, this convention operates with doubled vowels.

Do not hyphenate:

1. a noun compound of a spelled-out number and prefix, as in mideighties (but do hyphenate prefix plus numerals, as in mid-1980s).

2. chemical terms, as in: sodium nitrate, sodium silicate, or bismuth oxychloride

3. a compound modifier that follows the noun it modifies unless hyphenated in dictionary: Example: Her argument was well balanced. She was good-natured.

4. a compound modifier that includes an adverb ending in –ly: wholly fictitious

5. a hyphenated word at the end of a line other than at the hyphen

6. a proper noun except when absolutely unavoidable

7. contractions, such as: can't, wouldn't, don't, didn't, wasn't, he'll, they're, she'd

INCOMPLETE SENTENCES: Incomplete sentences are familiar occurrences in oral history because of its conversational nature. They are best ended with ellipses (…)。

INTERUPTIONS: On occasions when the interviewer interrupts the interviewee in mid-sentence, the interruption should be indicated with an em dash (—). When the interviewer interjects when the interviewee has paused, this should be indicated with an ellipses (…).

ITALICS: See QUOTATION MARKS for titles not in italics.

Italicize:

1. titles of whole published works, such as Plain Speaking

2. titles of books, bulletins, periodicals, pamphlets

3. titles of long poems

4. titles of plays and motion pictures

5. titles of long musical compositions: operas, operettas, musical comedies, oratorios, ballets, tone poems, concertos, sonatas, concerti grossi, symphonies, and suites, but not descriptive titles or attributed titles

6. actual titles, rather than descriptive or attributed titles, of paintings, sculptures, drawings, mobiles; for instance, da Vinci's Mona Lisa is actually La Gioconda.

7. names of spacecraft, aircraft, and ships, except for abbreviations preceding the names, such as designations of class or manufacture, as follows: S.S. Olympic, H.M.S. Queen Elizabeth, U.S.S. Lexington, Friendship VII

8. foreign words and phrases that are not in common currency; when in doubt, don't italicize. Consult the dictionary; don't italicize a quotation in a foreign language

9. a foreign word or phrase when translation follows that foreign word or phrase; enclose
translation in quotation marks and precede translation by a comma: *J’ai mal à la tête, “I have a headache.”*
10. references to words as words, phrases as phrases, or letters as letters: "*Often is a word I seldom use.*"
11. in indexes, the cross-reference terms, *See* and *See also*
12. titles of legal cases, except in footnotes where only *ex parte, ex rel.,* and in *re* are italicized along with other Latin words
13. enumeration letters referring to subdivisions within a sentence or within a paragraph as well as those appearing in lists, when such letters are in lower case, such as *a, b,* or *c*
14. newspaper names and the city names that accompany them: *New York Times*. Note: Do not italicize any articles preceding a newspaper name. Example: the *Times.*

**LEGAL CASES:** Italicize titles of legal cases, with v. for versus: *Brown v. Board of Education of Topeka, Kansas*

**MONEY. See NUMBERS**

**NAMES: See also ABBREVIATIONS; CAPITALIZATION; ITALICS; QUOTATION MARKS**

The spelling of proper names of persons or locations is one of the transcriber’s most difficult tasks. Refer to your word list, which was prepared by the interviewee and interviewee for those names that might be unfamiliar to you. The office also has reference works for your work and the internet is also a very useful tool. If you are still stumped, please move on, making sure you indicate your uncertainly accordingly; e.g. Mr. Duberstyn(??) All such uncertainties should be resolved during the final edit phase.

Nicknames, pseudonyms: When nicknames are sued by the narrator (“Cookie,” “Peaches,” “Top,”) use quotation marks at the first mention, but drop the use of quotation marks for subsequent use.

**NUMBERS:**

In general, spell out whole numbers, whether cardinal or ordinal, from one to ninety-nine, and any of those numbers followed by hundred, thousand, hundred thousand, million, and so on, hyphenated or not.

sixty-nine
seventy-fifth
twenty-two hundred, but 2,367. Note: When there are several numbers in a sentence or a group of numbers includes numbers over one hundred, you may use numerals for brevity and consistency.

- Always spell out the number if it is the first word in a sentence.
When were you born? Nineteen sixty-five.
When were you born? In 1965.

- Spell out the number if it is the name of a street and under one hundred.
  454 Fourth Street
- Spell out decades such as fifties, sixties, but 1960s, 1970s.
- Use numerals for percentages.
  Only 45 percent of board members approved of the measure.

See also the chapter on numbers in the *Chicago Manual of Style*.

Do not spell out:

- street address numbers, intrabuilding numbers, highway numbers
  10 Downing Street
  304 Carroll Library
  IH35
- telephone numbers
- fractional sums of money above one dollar: $2.98
- dates: See also DATES above
  735 BC         mid-1950s
  AD 1066        the midfifties
  1990s          midfifties fashions
  24 February 1997 July 1997 (no comma)
- **Time of day**—use numerals when AM or PM follow or when typing a whole plus a fraction of an hour: (See “Small caps” under “Capitalization” above for proper formatting.)
  8:20 PM        four o’clock
  7:30           seven in the morning
- number elements in names of government bodies and subdivisions of 100th and higher, all union locals and lodges
  Thirty-sixth Infantry
  139th Tactical Wing
- parts of a book, such as chapter numbers, verse numbers
- percentages, as in 50 percent
- For consistency any sentence which contains numerals pertaining to the same category should have all numerals.
  The report stated that 7 [instead of seven] out of 265 students voted in the campus elections.

Exceptions:
  - The sentence begins with a number:
    Seven out of 265 students voted.
  - Numbers representing different categories:
    In the past ten years five new buildings of over 125 stories have been erected in the city.
Military Units: Military unit names should be transcribed using numbers, and not by spelling them out. Examples are provided below.

- Battalions and Regiments: 2nd Battalion, 25th Infantry Regiment (In this example, the 2nd Battalion is a unit within the 25th Regiment); 158th Fighter Group
- Divisions: 7th Infantry Division, 1st Marine Division
- Corps: Corps designations are symbolized with Roman Numerals. X Corps

Numbers as numbers:
When spoken of or referred to as numbers, they may be enclosed in quotation marks or italicized; either is acceptable, but be consistent throughout the transcript.

Plurals of numbers:
- Spelled-out numbers form plurals like any other noun: the twenties and thirties
- Numerals form plurals by adding *s* alone, with no apostrophe: 1920s and 1930s

When connecting figures with a prefix or suffix, add the hyphen in the appropriate place if the compound word is adjectival. Connect numbers expressed in words to a prefix or suffix with a hyphen:
- twenty-odd

The suffix *fold* is an exception

PAGE NUMBERS: In final copies of memoirs, lower-case Roman numerals are used on auxiliary pages preceding the main text. This material should include the title page, abstract page and table of contents. Title page is considered to be page i but is not marked.

For text, appendix, and index pages, center the page numbers (in Arabic figures i.e., 1, 2, 3) one-half inch from the bottom edge of the paper in the page footer. Number appendix and index in sequence with the text pages and place the appendix pages between the end of the text and the index.

When an interview consists of multiple sessions, each separate interview session will have its own transcript, except for the final edit, where the transcripts will be combined into one word processing document. Number each transcript in a series sequentially. For example, if there are fifty-five pages of transcription for the first session, the pagination on the second transcript would begin with ‘56’.

PARAGRAPHING: Indent for paragraphs where topics change, where subtopics are introduced, or where other dialogue is introduced. This may be very difficult to judge as you are typing and is often left up to the editor.

- For the initial transcript, retain double-spacing for a new paragraph. Do not add additional space
- For the Final Transcript, each paragraph should be separated by 12 points.
Parentheses. See Sounds in Recording Other Than Talking—Parentheses

Plurals. See also Numbers.

- Compound words formed with prepositions are pluralized by forming the plurals of the first nouns in the compounds:
  fathers-in-law, sergeants-major
- Capital letters of the alphabet are pluralized by adding s or ’s:
  Zs
  Use the apostrophe only where confusion is possible:
  A’s, not As
- Lowercase letters form the plural by adding ’s:
  p’s and q’s
- Foreign words are made plural, unless Americanized, according to the customs proper to the particular languages. For example, in Hebrew, the plural of Kibbutz is formed by adding im: Kibbutzim.
- Abbreviations are pluralized by adding s when in the form of acronyms, initialisms, or reverse acronyms without periods:
  GREs
  When periods are used, add an apostrophe:
  B. K.’s
- Proper nouns: Add s to the singular if the addition does not make an extra syllable:
  six King Georges
  Add es to the singular form if the addition creates an extra syllable:
  six King Charleses
  Nouns—including names of persons—that end in s take addition of es to form the plural:
  The three Loises are friends with the three Marys.
  The hall was full of Joneses and Martins.

Note that the apostrophe is never used to denote the plural of a personal name.

► Return to Contents

Possessives: Follow the standard rules for possessives.
For proper nouns, add ’s to most, even those ending in sibilant sounds, except Jesus’ and Moses’. Example: Charlie’s, Frances’s.
For plural possessives, the apostrophe goes at the end: the Smiths’.
Collective nouns are exceptions, as in children’s.

► Return to Contents

Punctuation: Transcript punctuation follows The Chicago Manual of Style, 15th ed. See also Dashes; Ellipses; Hyphens; Quotation Marks

► Return to Contents

Quotation Marks:
1. When a direct expression is spoken by one person (I, he, she), set apart the expression with commas, use opening and closing quotation marks, and capitalize the first letter of the first word quoted. Example: She said, "I am going to graduate in May."
2. When a direct expression is spoken by more than one person (we, they), do not use quotation marks, but do set apart the expression with commas and do capitalize the first letter of the first word quoted. Example: They said, What are you doing here?
3. When a thought is quoted, do not use quotation marks, but do set the thought apart by commas and capitalize the first letter of the first word quoted. Example: I thought, Where am I?

Enclose in quotation marks when text refers to
1. titles of articles in periodicals
2. book chapter titles
3. book divisions other than chapter titles: sections, paragraphs, charts, and other labeled book parts
4. dissertation titles
5. essay titles
6. newspaper headlines (in all capital letters)
7. poems (short, not book length)
8. radio program titles
9. sermon titles
10. short musical composition titles when not designated by number
11. song titles
12. short story titles
13. television program titles
14. theses (unpublished)
15. lecture titles
16. titles of formal courses of study
17. debate topics

Do not enclose in quotation marks:
1. names or words used in conjunction with the words call, called, named, or words with similar meanings. Examples: Call me Adam. We named the dog Bowser.
2. the word yes or the word no other than in a sentence which includes other direct discourse. Examples: He couldn't say no, yet he didn't really want to say yes. She said, "No," when asked, "Do you care to join us?"
3. thoughts or paraphrases, as in, I thought to myself, Who does she think she is?

Punctuation with quotation marks:
The period and the comma always stay inside the quotation marks. Example: "I'm ready for lunch," she said, "but it's only ten o'clock."
The semicolon and the colon always stay outside the quotations. Example: With trepidation, she scanned "The Raven"; it was too eerie for her tastes.
The em dash, exclamation mark, and question mark are within the quotation marks when they apply only to the quotation. Examples: She began to say, "In the spring of 1920--" and then remembered it was a year later. She began by saying, "In the spring of 1920,"--I think it was
really 1921--"I graduated from the U. of I. in 1973 and began teaching school."

**RECORDING TRANSITIONS:** ALPL transcribers may transcribe either tape recorded interviews, or digitally recorded interviews.

Transcripts of tape recorded interviews: Indicate transitions by inserting a separate line, left justified with the appropriate notation, in parentheses.

- recording breaks:
  - (End of Side One, Tape One)
  - (End of Side Two, Tape One; Tape Two begins)

Transcripts of tape recorded or digitally recorded interviews:

- a pause in recording, when recording is turned off and then on again, when sound fades out, et cetera:
  - (pause in recording)
- the end of the interview:
  - (end of interview)

Transitions indicating the end of one session and the beginning of a new session (usually conducted on a separate date). Information is centered on the page, spaced with two blank lines both before and after the body text. See Appendix 4 “Final Transcript Format Guidelines.

**REFERENCE WORKS:** The office has a good supply of reference books on many subjects. It’s a good idea to ask what sources are available before you begin a transcribing project. For stylistic purposes, consult the dictionary and *The Chicago Manual of Style*; if the two conflict, try to follow the *Chicago Manual of Style*.

**RELIGIOUS NAMES AND TERMS:** The institute prefers a “down” style of capitalization for religious names and terms. For a complete guide to capitalization of religious terms, the names of deities and religious groups, movements, organizations, and religious writings, see the *Chicago Manual of Style*, 15th edition, pages 347-353.

**SLANG. See SPELLING PROBLEMS.**

**SOUNDS IN RECORDING OTHER THAN TALKING—PARENTHESES:** Nonverbal sounds or events which occur in the recording are noted and enclosed in parentheses, especially if they intrude significantly or affect the intelligibility of the recording and certainly if they provoke a response from those present. For such notations, use no capital letters,
unless for proper nouns or proper adjectives, and no ending punctuation. When these occur at
the end of a sentence or a clause, position them after the punctuation. Reserve the use of
parentheses for such activity notes.

- Descriptive terms:
  (laughs) when speaker laughs
  (Jeffrey laughs) when person other than speaker laughs
  (laughter) or (both laugh) when more than one laughs.
  (unintelligible)
  (sighs)
  (weeps) when crying is audible
  (telephone rings)
  (knock at the door)

- Avoid editorializing. Use (both talking at once) or (speaking at same time)—NOT
  (interrupts); use (laughs), not (laughs rudely).

SPACING

- one spaces after a period and after a colon
- one space between words and before and after parentheses in the middle of a sentence
- no space before or after em dashes (—)
- one space between initials in a name (e.g. J. F. Kennedy)
- When something has been italicized, it may look as though there is no space before or
  after the italicized text. To verify spaces, increase the font size and/or change
  Microsoft Word options so that formatting marks are visible (from the menu bar at the
  top of the document window, click on Tools ➔ Options, select the View tab, and in
  the Formatting Marks section, make sure that the box next to Spaces is checked).

SPELLING

- When a speaker spells a word, capitalize appropriately and separate letters with
  hyphens:
  M-a-t-t-o-o-n
- Follow the exact words of the speaker:
  They called him Screech, spelled capital S-c-r-double e-c-h.

► Return to Contents

SPELLING PROBLEMS. See also ABBREVIATIONS; CAPITALIZATION;
DIVISION; HYPHENS; NUMBERS).

- Always use the word processing software’s spell-check function before printing and
  always look up a word if you are not completely sure of its spelling. When the
dictionary allows more than one spelling of a word, chose the first one listed.

<table>
<thead>
<tr>
<th>DO</th>
<th>DON’T</th>
</tr>
</thead>
<tbody>
<tr>
<td>for a while</td>
<td>for awhile</td>
</tr>
<tr>
<td>awhile ago</td>
<td>a while ago</td>
</tr>
<tr>
<td>all right</td>
<td>alright</td>
</tr>
</tbody>
</table>
Transcription & Editing Style Guide

DO

until, till  ‘til
nowadays  now-a-days
apiece  a piece
inasmuch as  in as much as
insofar as  in so far as
Channel 10  Channel Ten
a lot  alot
et cetera  etc.
okay  O.K.

DON’T


• Always check the interview files to locate a word list for each recording. Interviewers may make lists to accompany the recording; using the lists saves time and results in a more accurate transcript. Please include the word list with the transcript when passing it on to the audit checker or the final editor.

• Spellings for slang and certain words and expressions pronounced in regional dialect are available in dictionaries or reference works in the office. Words of informal language, such as yeah and yep, may be transcribed verbatim if they are important in capturing the personality of the interviewee and occur in the dictionary. Words commonly pronounced together in spoken English—such as gonna (going to), sorta (sort of), and kinda (kind of)—are in the unabridged dictionary and may be used in the first edited version of the transcript. In general, however, we recommend not typing such colloquialism, but to rather retain the proper spelling of a word unless it very much helps define the true character of the narrator. If you do retain them the narrator may often edit them out anyway.

• Interviewees occasionally coin words, either humorously or to convey a meaning for which they cannot find an existing word. If you cannot find a word in any dictionary but can hear it clearly and can devise a reasonable spelling for it, transcribe it and place it in quotation marks the first time it occurs. Do not use quotation marks for every occurrence of the coined word, however, as it makes for tedious reading.

TIME: See also NUMBERS

UNDERLINE: Use underlining for emphasis, but only sparingly.

TAPE BREAKS. See RECORDING TRANSITIONS

TITLES. See ABBREVIATIONS; ITALICS; NAMES; QUOTATION MARKS

UH-HUH, UM-HM, UNH-UH. See FEEDBACK WORDS

UNINTELLIGIBLE SPOTS IN RECORDING

• When speech on a recording is unintelligible, first play it at higher volume and/or slower speed. Next, ask someone else to listen. Don’t struggle alone.
• If you can make an educated guess, type the closest possible approximation of what you hear, underline the questionable portion, and add two question marks in parentheses.
I went to school in Maryville(??) or Maryfield(??).
• If you and those you consult cannot make a guess as to what is said, leave a blank line and two question marks in parentheses. This will let interviewees know when you need help in clarifying information.
We’d take our cotton to Mr. _________(??)’s gin in Cameron.
• If a speaker lowers his or her voice, turns away from the microphone, or speaks over another person, it may be necessary to declare that portion of recording unintelligible.
When he’d say that, we’d—(laughs; unintelligible).

WORD LISTS: Interviewers are asked to make word lists during their interviews—lists of words and names spoken in the course of their interviews which may not be familiar to everyone. When you begin working with a new recording, look in the interviewee’s Interview Folder for a word list and use it as you transcribe or edit. Add to it as you verify other words and names.

Appendix 1: Interview Numbering Protocol
Appendix 2: ALPL File Naming Protocol
Appendix 3: Transcript Format Guidelines
Appendix 4: Final Transcript Format Guidelines
Interview with Jane Doe

Interview #1: October 19, 2006
Interviewer: John Q. Publician

Publician: I’m John Q. Publician, a volunteer at the Abraham Lincoln Presidential Library.

Today is October 19, 2006, and I am interviewing Jane Doe at her residence in Springfield, Illinois. This interview is part of the library’s Family Memories Oral History Project. Good morning Jane.

Doe: Good morning John. I’m pleased to be here talking about my life and my working career.

Publician: I’d like to start with a little bit of your parents’ background, their ethnic background, careers, and those kinds of things.

Doe: Well. ... In all honesty, I’m really a mixture of a lot of things, a Heinz 57 type of gal, if you know what I mean. My farther is half Dutch and a bunch of other stuff – English I think, some German and even some Bohemian. But I’m not sure about the particulars. His family came here around the turn of the century, and they settled in Chicago – somewhere up there. My mom’s a Sacheshee, at least that’s her maiden name. They’re, ... well, what are they? French I think, but she’s got some Swedish blood in her as well, and some other stuff. I’m not really sure, except I’ve got a little bit of everything. I’ve even heard that there’s some Cherokee blood in there on my mother’s side – at least that’s what I always hear at the family reunions.

Publician: My records show that you were born in Carbondale in 1938. How did your parents end up in southern Illinois?
Doe: Well, my mother was born in Makanda, which is southern Illinois. She met my dad when he came south during the depression to look for work in the coal mines, or in timber, any kind of work he could find. He met my mom at church, I think. At least that what they told us kids. We always kind of wondered about that; thought maybe they met at night school because my mom was teaching reading classes to adults about the time they met. But my dad was a real proud guy, and he would never have admitted to us kids that he couldn’t read when he met my mom, but maybe I should be telling you that kind of stuff.

Publician: Where was your dad working at that time?

Doe: Well, … let me think. … Can we turn that thing off for a while? I need to get some papers if I can find them.

Publician: Sure

(Pause in Recording)

Doe: Okay, here’s the stuff I was looking for. It says that my father ….
Publician: I’m John Q. Publician, a volunteer at the Abraham Lincoln Presidential Library. Today is October 19, 2006, and I am interviewing Jane Doe at her residence in Springfield, Illinois. This interview is part of the library’s Family Memories Oral History Project. Good morning Jane.

Doe: Good morning John. I’m pleased to be here talking about my life and my working career.

Publician: I’d like to start with a little bit of your parents’ background, their ethnic background, careers, and those kinds of things.

Doe: Well. ... In all honesty, I’m really a mixture of a lot of things, a Heinz 57 type of gal, if you know what I mean. My farther is half Dutch and a bunch of other stuff – English I think, some German and even some Bohemian. But I’m not sure about the particulars. His family came here around the turn of the century, and they settled in Chicago – somewhere up there. My mom’s a Sacheshee, at least that’s her maiden name. They’re, … well, what are they? French I think, but she’s got some Swedish blood in her as well, and some other stuff. I’m not really sure, except I’ve got a little bit of everything. I’ve even heard that there’s some Cherokee blood in there on my mother’s side – at least that’s what I always hear at the family reunions.

Publician: My records show that you were born in Carbondale in 1938. How did your parents end up in southern Illinois?

Doe: Well, my mother was born in Makanda, which is southern Illinois. She met my dad when he came south during the depression to look for work in the coal mines, or in timber, any kind of work he could find. He met my mom at church, I think. At least that what they told us kids. We always kind of wondered about that; thought maybe they met at night school because my mom was teaching reading classes to adults about the time they met. But my dad was a real proud guy, and he would never have admitted to us kids that he couldn’t read when he met my mom, but maybe I should be telling you that kind of stuff.

Publician: Where was your dad working at that time?

Doe: Well, … let me think. … Can we turn that thing off for a while? I need to get some papers if I can find them.

Publician: Sure.
(Pause in Recording)

Doe: Okay, here’s the stuff I was looking for. It says that my father …